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Chapter 1. Installation overview

An installation of is complete when you install, configure, and deploy . The
Installation Guide provides detailed information about installing, configuring, and
deploying .

Use the Installation Roadmap section to obtain a broad understanding about using
the Installation Guide.

Installation roadmap
Use the installation roadmap to quickly find the information that you need for
installing IBM® SPSS® Modeler Advantage Enterprise Marketing Management
Edition.

You can use Table 1 to review the order that tasks that must be completed for
installing IBM SPSS Modeler Advantage Enterprise Marketing Management
Edition.

Table 1. IBM SPSS Modeler Advantage Enterprise Marketing Management Edition installation roadmap

Phase Details Documentation

1. Install or upgrade
the operating system
software.

Supported operating systems:

v Unix

v Linux

v Windows

Microsoft Windows Server 2012R2 is a
64-bit platform. There are no 32-bit
versions.

Refer to the documentation for your
operating system.

2. Install or upgrade
the database server.

DB2 Enterprise Server Edition, version 10.1
FP 2

The runtime environment can require several
databases.

See “Configuring a DB2 database” on page 9.
Also refer to the IBM Marketing Platform
Installation Guide or IBM Marketing Platform
Upgrade Guide.

3. Install or upgrade
the application server.

Supported application servers:

v Oracle WebLogic

v IBM WebSphere version 8.5

With the IBM Marketing Software installer,
the WebSphere Application Server will be
automatically configured to run IBM
Marketing Software.
Note: Be sure that WebSphere is shut
down before beginning the installation.

Refer to the documentation for your
application server.

4. Install or upgrade
IBM Marketing
Platform version 9.1.

Refer to the IBM Marketing Platform
Installation Guide or IBM Marketing Platform
Upgrade Guide.

5. Install or upgrade
IBM Campaign
version 9.1.

Refer to the IBM Campaign Installation Guide
or IBM Campaign Upgrade Guide.
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Table 1. IBM SPSS Modeler Advantage Enterprise Marketing Management Edition installation roadmap (continued)

Phase Details Documentation

6. Install IBM SPSS
Modeler Advantage
Enterprise Marketing
Management Edition
version 8.0.

There are three methods for installation: GUI,
console, and silent install mode.

See the topics in Chapter 3, “Installing ,” on
page 9.

7. Complete the
installation.

See “Completing the installation” on page
19.

8. Start the SPSS
Listener.

See “Starting IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition
Listener process in UNIX” on page 20.

9. Install the SPSS
Deployment Manager
and configure the
connections.

See the topics in Chapter 4, “Configuring
IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition after
installation,” on page 23.

10. Configure the
integration.

Refer to the IBM Campaign and IBM SPSS
Modeler Advantage Enterprise Marketing
Management Edition Integration Guide, chapter
2.

How the installers work
You must use the suite installer and the product installer when you install or
upgrade any IBM Marketing Software product. For example, for installing , you
must use the IBM Marketing Software suite installer and the IBM installer.

Make sure that you use the following guidelines before you use the IBM Marketing
Software suite installer and the product installer:
v The suite installer and the product installer must be in the same directory on the

computer where you want to install the product. When multiple versions of a
product installer are present in the directory with the master installer, the master
installer always shows the latest version of the product on the IBM Marketing
Software Products screen in the installation wizard.

v If you are planning to install a patch immediately after you install an IBM
Marketing Software product, make sure that the patch installer is in the same
directory as that of the suite and product installers.

v The default top-level directory for IBM Marketing Software installations is
/IBM/IMS for UNIX or C:\IBM\IMS for Windows. However, you can change the
directory during installation.

Modes of installation
The IBM Marketing Software suite installer can run in one of the following modes:
GUI mode, console mode, or silent mode (also called the unattended mode). Select
a mode that suits your requirements when you install .

For upgrades, you use the installer to perform many of the same tasks that you
perform during the initial installation.
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GUI mode

Use the GUI mode for Windows or the X Window System mode for UNIX to
install by using the graphical user interface.

Console mode

Use the console mode to install by using the command line window.

Note: To display the Installer screens correctly in console mode, configure your
terminal software to support UTF-8 character encoding. Other character encoding,
such as ANSI, will not render the text correctly, and some information will not be
readable.

Silent mode

Use the silent or unattended mode to install multiple times. The silent mode uses
response files for installation, and does not require user input during the
installation process.

Note: Silent mode is not supported for upgrade installations in clustered web
application or clustered listener environments.

IBM SPSS Modeler Advantage Enterprise Marketing Management
Edition documentation and help

IBM SPSS Modeler Advantage Enterprise Marketing Management Edition provides
documentation and help for users, administrators, and developers.

Table 2. Get up and running

Task Documentation

View a list of new features, known issues, and
workarounds.

IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition Release Notes

Configure the integration. IBM Campaign and IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition Integration Guide

Table 3. Get help

Task Instructions

Open online help. 1. Choose Help > Help for this page to open a
context-sensitive help topic.

2. Click the Show Navigation icon in the help window
to display the full help.

You must have web access to view context-sensitive
online help. Contact IBM Support for more information
about accessing and installing IBM Knowledge Center
locally for offline documentation.

Obtain PDFs. Use either of the following methods:

v Choose Help > Product Documentation to access
Campaign PDFs.

v Choose Help > All IBM Marketing Software Suite
Documentation to access all available documentation.
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Table 3. Get help (continued)

Task Instructions

Get support. Go to http://www.ibm.com/. Scroll down to the Need
more help? section and click Support portal.
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Chapter 2. Planning the installation

When you plan your installation, you must ensure that you have set up your
system correctly, and that you have configured your environment to deal with any
failures.

IBM SPSS Modeler Advantage Enterprise Marketing Management
Edition components

IBM SPSS Modeler Advantage Enterprise Marketing Management Edition has the
following components:
v IBM Analytical Decision Management including Modeler Advantage
v IBM SPSS Modeler Server Professional (without Modeler Client)
v IBM SPSS Collaboration and Deployment Services (C&DS)

Prerequisites
Before you install or upgrade any IBM Marketing Software product, you must
ensure that your computer complies with all of the prerequisite software and
hardware.

System requirements

For information about system requirements, see the Recommended Software
Environments and Minimum System Requirements guide.

In order for Opportunity Detect to connect to the DB2 database, the DB2
installation must include the install header files in the /home/db2inst1/include
directory on client machine. To include the header files in the installation, select
the Custom Install option when you install DB2 and select the Base Application
Development Tools feature.

DB2 requirements

In order for Opportunity Detect to connect to the DB2 database, the DB2
installation must include the install header files in the home/db2inst1/include
directory on client machine. To include the header files in the installation, select
the Custom Install option when you install DB2 and select the Base Application
Development Tools feature.

Network domain requirements

The IBM Marketing Software products that are installed as a suite must be
installed on the same network domain to comply with the browser restrictions that
are designed to limit the security risks that can occur with cross-site scripting.

JVM requirements

IBM Marketing Software applications within a suite must be deployed on a
dedicated Java™ virtual machine (JVM). IBM Marketing Software products
customize the JVM that is used by the web application server. If you encounter
errors that are related to the JVM, you must create an Oracle WebLogic or
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WebSphere® domain that is dedicated to the IBM Marketing Software products.

Knowledge requirements

To install IBM Marketing Software products, you must have a thorough knowledge
of the environment in which the products are installed. This knowledge includes
knowledge about operating systems, databases, and web application servers.

Internet browser settings

Make sure that your internet browser complies with the following settings:
v The browser must not cache web pages.
v The browser must not block pop-up windows.

Access permissions

Verify that you have the following network permissions to complete the
installation tasks:
v Administration access for all necessary databases

Note: Administrator must have CREATE, SELECT, INSERT, UPDATE, DELETE, and
DROP rights for both tables and views.

v Read and write access to the relevant directory and subdirectories for the
operating system account that you use to run the web application server and
IBM Marketing Software components

v Write permission for all files that you must edit
v Write permission for all directories where you must save a file, such as the

installation directory and backup directory if you are upgrading
v Appropriate read, write, and execute permissions to run the installer

Verify that you have the administrative password for your web application server.

For UNIX, all installer files for IBM products must have full permissions, for
example, rwxr-xr-x.

JAVA_HOME environment variable

If a JAVA_HOME environment variable is defined on the computer where you install
an IBM Marketing Software product, verify that the variable points to a supported
version of JRE. For information about system requirements, see the IBM Marketing
Software Recommended Software Environments and Minimum System Requirements
guide.

If the JAVA_HOME environment variable points to an incorrect JRE, you must clear
the JAVA_HOME variable before you run the IBM Marketing Software installers.

You can clear the JAVA_HOME environment variable by using one of the following
methods:
v Windows: In a command window, enter set JAVA_HOME= (leave empty) and

press Enter.
v UNIX: In the terminal, enter export JAVA_HOME=(leave empty) and press Enter.

The IBM Marketing Software installer installs a JRE in the top-level directory for
the IBM Marketing Software installation. Individual IBM Marketing Software
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application installers do not install a JRE. Instead, they point to the location of the
JRE that is installed by the IBM Marketing Software installer. You can reset the
environment variable after all installations are complete.

For more information about the supported JRE, see the IBM Marketing Software
Recommended Software Environments and Minimum System Requirements guide.

Installation Manager requirement

Installation Manager (Version 1.6.2 or later) must be installed on your machine
before you start installing .

Chapter 2. Planning the installation 7
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Chapter 3. Installing

You must run the IBM Marketing Software installer to start the installation of . The
IBM Marketing Software installer starts the installer during the installation process.
Make sure that the IBM Marketing Software installer and the product installer are
saved at the same location.

Each time that you run the IBM Marketing Software suite installer, you must first
enter database connection information for the Marketing Platform system tables.
When the installer starts, you must enter the required information for .

Note: The IBM Marketing Software installer requires information about Marketing
Platform.

Important: Before you install , make sure that the available temporary space on
the computer where you install is more than three times the size of the installer.

For information about installing on clustered environment, see "Cluster
Configuration" in the IBM SPSS Collaboration and Deployment Services (C&DS) Guide.

Installation files

The installation files are named according to the version of the product and the
operating system on which they must be installed, except UNIX. For UNIX,
different installation files exist for the X Window System mode and the console
mode.

The following table displays examples of the installation files that are named
according to the product version and the operating system:

Table 4. Installation files

Operating system Installation file

UNIX: X Window System mode Product_N.N.N.N_linux64.bin, where Product is the name
of your product, and N.N.N.N is the version number of
your product.

UNIX: Console mode Product_N.N.N.N.bin, where Product is the name of your
product, and N.N.N.N is the version number of your
product. This file can be used for installation on all
UNIX operating systems.

Configuring a DB2 database
You must create and configure a database to store the IBM SPSS Modeler
Advantage Enterprise Marketing Management Edition system tables.

Note: In the following steps, the DB2 user and schema names WPADMIN are
examples. It is possible to install everything under the DB2ADMIN default
administrator login for DB2. Install with separate schemas and users for each
database to simplify administration and the granting of rights. DB2 will not allow
the user who is connected to the database grant themselves access rights.
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To configure the DB2 database for the IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition and IBM Campaign integration.
1. Under user WPADMIN schema WPADMIN, create a database named

SPSSMAME to store the IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition System Tables.

2. Configure the database properly as indicated in the following sample SQL
statements:
/* SPSS MAME Database Creation Script */
CREATE DATABASE SPSSMAME ON DB2 USING CODESET UTF-8 TERRITORY
US COLLATE USING SYSTEM;

CONNECT TO SPSSMAME;

CREATE BUFFERPOOL CDS8K IMMEDIATE SIZE 250 AUTOMATIC PAGESIZE 8 K;

CREATE REGULAR TABLESPACE CDS8K PAGESIZE 8 K MANAGED BY AUTOMATIC STORAGE
EXTENTSIZE 8 OVERHEAD 10.5 PREFETCHSIZE 8 TRANSFERRATE 0.14 BUFFERPOOL CDS8K
DROPPED TABLE RECOVERY ON;

COMMENT ON TABLESPACE CDS8K IS ’’;

CREATE BUFFERPOOL CDSTEMP IMMEDIATE SIZE 250 PAGESIZE 32 K;

CREATE SYSTEM TEMPORARY TABLESPACE CDSTEMP PAGESIZE 32 K MANAGED BY AUTOMATIC
STORAGE EXTENTSIZE 16 OVERHEAD 10.5 PREFETCHSIZE 16 TRANSFERRATE 0.14
BUFFERPOOL "CDSTEMP";

COMMENT ON TABLESPACE CDSTEMP IS ’’;

CONNECT RESET;

Before you install IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition

Before you begin to install IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition, review the following information.
v You need the server information to your database schema, and the path to your

WebSphere or Web Logic server profile directory. The following is an example of
the information that you must provide:
-Database

-Database type : db2
-Database host : localhost
-Database port : 50000
-Database username : db2instl
-Database name : SPSSMAME

-Application server
-Application server type : websphere
-Server installation directory path : /opt/IBM/WebSphere/AppServer
-JVM path : /opt/IBM/WebSphere/AppServer/java
-WebSphere profile : /opt/IBM/WebSphere/AppServer/profiles/AppSrv01
-WebSphere server name : server1
-WebSphere node : localhostNode01
-Admin security enabled : true
-Application server username : admin

-Keystore
-Reuse keystore : false

-Deployment mode
-Deployment : Automatic
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v Be sure to specify passwords when asked.
v Be sure that you have a root directory that contains the installer code modules

(for example, C:\Installers\IMS).
v Be sure to copy the IBM SPSS Modeler Advantage Enterprise Marketing

Management Edition install packages in the installers directory.

During installation

You may see the following warning during installation:
(<unknown>:38376): Gtk-WARNING **: Unable to locate theme engine in module_path:

“clearlooks”,

This does not impact the success of the installation.

After installation

When the installation completes, the following summary screen displays:

Installing IBM SPSS Modeler Advantage Marketing Edition by using the
GUI mode

For Windows, use the GUI mode to install IBM SPSS Modeler Advantage
Marketing Edition. For UNIX, use the X Window System mode to install IBM SPSS
Modeler Advantage Marketing Edition.
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Make sure that the IBM Marketing Software installer and the IBM SPSS Modeler
Advantage Marketing Edition installers are in the same directory on the computer
where you want to install IBM SPSS Modeler Advantage Marketing Edition.

Before you install IBM SPSS Modeler Advantage Marketing Edition, make sure that
you have configured the following elements:
v An application server profile
v A database schema

For more information about configuring application server, see "Configuration" in
the IBM SPSS Collaboration and Deployment Services (C&DS) Guide.

Complete the following actions to install IBM SPSS Modeler Advantage Marketing
Edition by using the GUI mode:
1. Go to the folder where you have saved the IBM Marketing Software installer

and double-click the installer to start it.
2. Click OK on the first screen to see the Introduction window.
3. Follow the instructions on the installer, and click Next. Use the information in

the following table to take the appropriate actions on each window in the IBM
Marketing Software installer:

Table 5. IBM Marketing Software installer GUI

Window Description

Introduction This is the first window of the IBM
Marketing Software suite installer. You can
open the IBM SPSS Modeler Advantage
Marketing Edition Installation Guide from this
window.

Click Next to go to the next window.

Response Files Destination Click the Generate Response File check box
if you want to generate response files for
your product. Response files store the
information that is necessary for the
installation of your product. You can use
response files for an unattended.

Click Choose to browse to a location where
you want to store the response files.

Click Next to go to the next window.

IBM Marketing Software Products In the Install Set list, select Custom to select
the products that you want to install.

In the Install Set area, you can see all the
products whose installation files are in the
same directory on your computer.

In the Description field, you can view the
description of the product that you select in
the Install Set area.

Click Next to go to the next window.
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Table 5. IBM Marketing Software installer GUI (continued)

Window Description

Installation Directory Click Choose to browse to the directory
where you want to install IBM Marketing
Software.

Click Next to go to the next window.

Select Application Server Select one of the following application
servers for the installation:

v IBM WebSphere

v Oracle WebLogic

Click Next to go to the next window.

Platform Database Type Select the appropriate Marketing Platform
database type.

Click Next to go to the next window.

Platform Database Connection Enter the following information about your
database:

v Database host name

v Database port

v Database name or System ID (SID)

v Database user name

v Database password

Click Next to go to the next window.
Important: If IBM Marketing Software
products are installed in a distributed
environment, you must use the machine
name rather than an IP address in the
navigation URL for all of the applications in
the suite. Also, if you are on a clustered
environment and choose to use ports that
are different from the default ports 80 or 443
for your deployment, do not use a port
number in the value of this property.

Review and confirm the JDBC connection.

Click Next to go to the next window.

Preinstallation Summary Review and confirm the values that you
added during the installation process.

Click Install to start the installation process.

4. The IBM SPSS Modeler Advantage Marketing Edition installer opens. Use the
information in the following table to navigate the IBM SPSS Modeler
Advantage Marketing Edition installer:
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Table 6. IBM SPSS Modeler Advantage Marketing Edition installer GUI

Window Description

Introduction This is the first window of the IBM SPSS
Modeler Advantage Marketing Edition
installer. You can open the IBM SPSS
Modeler Advantage Marketing Edition
Installation Guide from this window.

Click Next to go to the next window.

Software Licence Agreement Carefully read the agreement. Use Print to
print the agreement. Click Next after you
accept the agreement.

IBM SPSS MA Marketing Edition
Components

Select the components that you want to
install. You can select one or more
components from the following list:

v SPSS Collaboration and Deployment
Services (CnDS).

Select the SPSS C&DS server installation
and the SPSS C&DS server configuration
check boxes to enable the SPSS C&DS tool
to install and configure C&DS at once.

If you want to configure SPSS C&DS later,
do not select the SPSS C&DS server
configuration check box.

v SPSS Modeler Server

v SPSS Decision Management

Click Next to go to the next window.

Installation Directory Click Choose to browse to the directory
where you want to install IBM SPSS
Modeler Advantage Marketing Edition.

Click Next to go to the next window.

Preinstallation Summary Review and confirm the values that you
added during the installation process.

Click Install to start the installation process.

You can see the installation progress on the
Installing IBM SPSS MA Marketing Edition
window. During the installation of IBM SPSS
Modeler Server, the IBM SPSS Collaboration
and Deployment Services Configuration Tool
(C&DS configuration tool) opens.

5. Use the information in the following table to navigate the IBM SPSS
Collaboration and Deployment Services Configuration Tool window:

Table 7. IBM SPSS Collaboration and Deployment Services Configuration Tool GUI

Window Description

Welcome Click Next to start the configuration.
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Table 7. IBM SPSS Collaboration and Deployment Services Configuration Tool
GUI (continued)

Window Description

Application Server Select one of the following application
servers:

v IBM WebSphere

v Oracle WebLogic

v JBoss

Important: Do not select JBoss as IBM does
not support IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition
installation by using JBoss.

Configure the appropriate information for
your application server.

Click Next to go to the next window.

Database In the Database Type field, select your
database type.

Enter the following information in the
corresponding fields:

v Host name

v Port

v Database name

v User name

v Password

Click Next to go to the next window.

Existing data If the database contains existing data,
complete one of the following actions by
selecting the corresponding check box:

v Preserve existing data

v Erase existing data

Click Next to go to the next window.

Encryption Assign a password for your Java Virtual
Machine (JVM) or select the Reuse existing
keystore check box to use an existing
keystore. If you select the Reuse existing
keystore check box, in the Keystore path
field, you must browse and select the
keystore file.

For more information about "keystore", see
"Configuration" in the chapter "Installation"
in the IBM SPSS Collaboration and Deployment
Services (C&DS) Guide.

Click Next to go to the next window.
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Table 7. IBM SPSS Collaboration and Deployment Services Configuration Tool
GUI (continued)

Window Description

Repository Admin Enter the password for the repository
administrator.

For more information about the admin user,
see "Configuration" in the chapter
"Installation" in the IBM SPSS Collaboration
and Deployment Services (C&DS) Guide.

Click Next to go to the next window.

Deployment mode Make sure that you select the Automatic
radio button.

Click Next to go to the next window.

Configuration summary Review the values that you selected.

Click Configure to start the deployment and
configuration.

The deployment and configuration process
might need several minutes to complete.
After the deployment and configuration is
complete, you can see the Installation
Complete window in the IBM SPSS Modeler
Advantage Marketing Edition installer.

Configuration successful Click Finish to exit the IBM SPSS
Collaboration and Deployment Services
Configuration Tool.

6. In the SPSS Components Installation Summary window, click Done to exit the
IBM SPSS Modeler Advantage Marketing Edition installer and go back to the
IBM Marketing Software installer.

7. Follow the instructions on the IBM Marketing Software installer to finish
installing IBM SPSS Modeler Advantage Marketing Edition. Use the
information in the following table to take the appropriate actions on each
window in the IBM Marketing Software installer.

Table 8. IBM Marketing Software installer GUI

Window Description

Deployment EAR file Specify whether you want to create an
enterprise archive (EAR) file to deploy your
IBM Marketing Software products.

Click Next to go to the next window.

Package EAR file You can see this window if you select Create
an EAR file for deployment in the
Deployment EAR file window.

Select the applications that you want to
package in the EAR file.
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Table 8. IBM Marketing Software installer GUI (continued)

Window Description

EAR file details Enter the following information for your
EAR file:

v Enterprise application identifier

v Display name

v Description

v EAR file path

EAR file details (continued) Select Yes or No to create an additional EAR
file. If you select Yes, you must enter the
details for the new EAR file.

Click Next to complete the installation of
your product.

Deployment EAR file Specify whether you want to create another
EAR file to deploy your IBM Marketing
Software products.

Click Next to go to the next window.

Installation Complete This window provides the locations of the
log files that are created during installation.

Click Previous if you want to change any
installation details.

Click Done to close the IBM Marketing
Software installer.

For information about deploying SPSS manually, see "Manual deployment" in
chapter "Installation" in the IBM SPSS Collaboration and Deployment Services
(C&DS) Guide.

Installing IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition using the console mode

The console mode allows you to install IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition using the command-line window. You can select
various options in the command-line window to complete tasks such as selecting
the products to install, or selecting the home directory for the installation.

Before you install IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition, ensure that you have configured the following.
v An application server profile
v A database schema

To display the installer screens correctly in console mode, configure your terminal
software to support UTF-8 character encoding. Other character encodings, such as
ANSI, do not render the text correctly, and some information is not readable with
these encodings.
1. Open a command-line prompt window and navigate to the directory where

you have saved the IBM Marketing Software installer and the IBM SPSS
Modeler Advantage Enterprise Marketing Management Edition installer.

2. Complete one of the following actions to run the IBM Marketing Software
installer.
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v For Windows, enter the following command:
ibm_ims_installer_full_name -i console

For example, IBM_Marketing_Software_Installer_11.0.0.0_win.exe -i
console

v For UNIX, invoke the ibm_ims_installer_full_name.sh file.
For example: IBM_Marketing_Software_Installer_11.0.0.0.sh

3. Follow the directions that are displayed in the command-line prompt. Use the
following guidelines when you have to select an option in the command-line
prompt:
v The default options are defined by the symbol [X].
v To select or clear an option, type the number that is defined for the option,

and then press Enter.
4. The IBM Marketing Software installer launches the IBM SPSS Modeler

Advantage Enterprise Marketing Management Edition installer during the
installation process. Follow the instructions in the command-line prompt
window of the IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition installer.

5. After you enter quit in the IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition installer command-line prompt window, the window
shuts down. Follow the instructions in the command-line prompt window of
the IBM Marketing Software installer to complete the installation of IBM SPSS
Modeler Advantage Enterprise Marketing Management Edition.

Note: If any error occurs during the installation, a log file is generated. You
must exit the installer to view the log file.

Installing IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition silently

Use the unattended or silent mode to install IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition multiple times.

Before you install IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition, make sure that you have configured the following elements:
v An application server profile
v A database schema

When you install IBM SPSS Modeler Advantage Enterprise Marketing Management
Edition by using the silent mode, response files are used to obtain the information
that is required during installation. You must create response files for a silent
installation of your product. You can create response files by using one of the
following methods:
v Using the sample response files as a template for creating your response files.

The sample response files are included with your product installers in the
ResponseFiles compressed archive. For more information about sample response
files, see “Sample response files” on page 19.

v Running the product installers in the GUI (Windows) or X Window System
(UNIX) mode or the console mode before you install the product in the silent
mode. One response file is created for the IBM Marketing Software suite
installer, and one or more response files are created for your product installer.
The files are created in the directory that you specify.
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Important: For security reasons, the installer does not save database passwords
in the response files. When you create response files, you must edit each
response file to enter database passwords. Open each response file and search
for PASSWORD to find where you must edit the response file.

When the installer runs in the silent mode, it looks for the response files in the
following directories sequentially:
v In the directory where the IBM Marketing Software installer is saved
v In the home directory of the user who installs the product

Make sure that all response files are in the same directory. You can change the path
where response files are read by adding arguments to the command line. For
example: -DUNICA_REPLAY_READ_DIR="myDirPath" -f myDirPath/
installer.properties

Use the following command for Windows:
v ibm_ims_installer_full_name -i silent

For example:
IBM_Marketing_Software_Installer_11.0.0.0_win.exe -i silent

Use the following command for Linux:
v ibm_ims_installer_full_name _operating_system .bin -i silent

For example:
IBM_Marketing_Software_Installer_11.0.0.0_linux.bin -i silent

Sample response files
You must create response files to set up a silent installation of . You can use
sample response files to create your response files. The sample response files are
included with the installers in the ResponseFiles compressed archive.

The following table provides information about sample response files:

Table 9. Description of sample response files

Sample response file Description

installer.properties The sample response file for the IBM Marketing Software
master installer.

installer_product initials and product version
number.properties

The sample response file for the installer.

For example, installer_ucn.n.n.n.properties is the
response file of the Campaign installer, where n.n.n.n is
the version number.

installer_report pack initials, product initials,
and version number.properties

The sample response file for the reports pack installer.

For example, installer_urpcn.n.n.n.properties is the
response file of the Campaign reports pack installer,
where n.n.n.n is the version number

Completing the installation
After you complete the installation, you must complete additional steps before you
configure IBM SPSS Modeler Advantage Enterprise Marketing Management
Edition.

After installation, complete the following steps.
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1. Check the install log for errors. If there are no errors in the install log, continue
with the next step.

2. In a Linux system, you need to increase the number of permitted processes by
entering the ulimit command. Add the command to the Linux startup to
ensure that the change is persistent.

Note: There is a process limit issue in Linux that prevents the SPSS WebSphere
Enterprise Application from starting or causes errors when you open the
WebSphere Console.
For example:
ulimit -n 8192
/opt/IBM/WebSphere/AppServer/bin/startServer.sh server1

3. Start WebSphere.
You should see the IBM SPSS Collaboration and Deployment Services
Enterprise Application listed.

4. Install the SPSS Deployment Manager on a Windows workstation.

Note: There is no Linux version of the SPSS Deployment Manager.
When you are ready to configure the Deployment Manager, the Listener needs
to be running or your login credentials will fail. Be sure to use the username
admin and the password you entered during the IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition installation.

Starting IBM SPSS Modeler Advantage Enterprise Marketing
Management Edition Listener process in UNIX

If IBM SPSS Modeler Advantage Enterprise Marketing Management Edition is
installed on Windows, the Modeler Server Listener process starts automatically as a
Windows service. However, in UNIX, you must start the process manually.
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Open a command prompt and navigate to the SPSS Modeler Server installation
directory. Run the following commands to manually start and stop IBM SPSS
Modeler Server:
v To start the server run: ./modelersrv.sh start
v To stop the server run: ./modelersrv.sh stop
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Chapter 4. Configuring IBM SPSS Modeler Advantage
Enterprise Marketing Management Edition after installation

You must install the IBM Deployment Manager after you successfully install IBM
SPSS Modeler Advantage Enterprise Marketing Management Edition. Use the
Deployment Manager to create server connections and resource definitions, which
enable the single sign-on feature between Marketing Platform and IBM SPSS
Modeler Advantage Enterprise Marketing Management Edition.

After you install IBM Deployment Manager, create the following connections:
v Administered server connection
v Content server connection

Note: Deployment Manager for IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition is available only on the Windows operating
system and not on UNIX.

Creating Administered Server connection
Use Deployment Manager to create an Administered Server connection in IBM
SPSS Modeler Advantage Enterprise Marketing Management Edition.

You must install Deployment Manager before you create an Administered Server
connection.

Complete the following steps to create an Administered Server connection:
1. Open Deployment Manager for SPSS.
2. Click File > New > Administered Server Connection.
3. In the Name field, enter the connection name.
4. In the Server URL field, enter the URL of the computer where SPSS is

deployed.
Use the same server name and port that you used to deploy Marketing
Platform and save the configuration.

Important: The port must be either http or https (not the console port).
For example, http://unicavmdemo:9080

5. Click Finish.

You can see the connection name in the left pane of the Deployment Manager.

Creating Content Server connection
Use Deployment Manager to create a Content Sever connection in IBM SPSS
Modeler Advantage Enterprise Marketing Management Edition.

Complete the following steps to create a Content Server connection:
1. Open Deployment Manager for SPSS.
2. Click File > New > Content Server Connection.
3. In the Name field, enter the connection name.
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The connection name must be same as you entered for the Administered Server
connection.

4. In the Server URL field, enter the URL of the computer where SPSS is
deployed.
Use the same server name and port that you used to deploy Marketing
Platform and save the configuration.

Important: The port must be either http or https (not the console port).
For example, http://unicavmdemo:9080

5. Click Finish.

You can see the connection name in the left pane of the Deployment Manager.

Creating Resource Definitions
Use Deployment Manager to create resource definitions in IBM SPSS Modeler
Advantage Enterprise Marketing Management Edition.

Complete the following steps to create a resource definition:
1. Open Deployment Manager for SPSS.
2. In the Deployment Manager, expand Resource Definitions. Right-click

Credentials, and click New > Credentials Definition.
3. In the Name field, enter modeler and click Next.
4. In the User ID and Password, and Confirm Password field, enter the

operating system's user name and password.
5. Leave the Security Provider field blank.
6. Click Finish.
7. In the Deployment Manager, expand Resource Definitions. Right-click

Servers, and click New > Server Definition.
8. In the Name field, enter modeler.
9. From the Types list, select Modeler Server and click Next.

Note: If Modeler Server is not listed, exit the Deployment Manager and
restart it. The Deployment Manager loads the new configurations from the
server and displays a message that indicates that the application is updating.

10. In the Host field, enter the computer name on which SPSS is deployed. For
example, usrlnmarcous1.servername.yourcompany.com

11. In the Port field, the default value is displayed as 28053.

Important: Do not change value for the Port field.
12. In the Default Data Path, enter one of the following options based on the

operating system:

Operating system Default data path

UNIX and Linus /

Windows \ with the drive letter (such as C:\)

13. Click Finish.

After you create the resource definitions, restart your SPSS server. Then, continue
with the configuration chapter of the IBM Campaign and IBM SPSS Modeler
Advantage Enterprise Marketing Management Edition Integration Guide
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Chapter 5. Uninstalling

Run the uninstaller to uninstall . When you run the uninstaller, the files that were
created during the installation process are removed. For example, files such as
configuration files, installer registry information, and user data are removed from
the computer.

When you install IBM Marketing Software products, an uninstaller is included in
the Uninstall_Product directory, where Product is the name of your IBM product.

If you manually remove the files in your installation directory instead of running
the uninstaller, the result might be an incomplete installation if you later reinstall
an IBM product in the same location. After uninstalling a product, its database is
not removed. The uninstaller only removes default files that are created during
installation. Any file that is created or generated after installation is not removed.

Note: On UNIX, the same user account that installed must run the uninstaller.
1. Make sure that the IBM SPSS Modeler Collaboration and Deployment Service

(C&DS) is uninstalled.
Open the Installation Manager and verify that C&DS is uninstalled. If C&DS is
not uninstalled, use the IBM Installation Manager to uninstall C&DS.

2. Complete one of the following steps to uninstall :
v Click the uninstaller that exists in the Uninstall_Product directory. The

uninstaller runs in the mode in which you installed .
v In a command-line window, navigate to the directory where the uninstaller

exists, and run the following command to uninstall by using the console
mode:
Uninstall_Product -i console

v In a command-line window, navigate to the directory where the uninstaller
exists, and run the following command to uninstall by using the silent mode:
Uninstall_Product -i silent

When you uninstall by using the silent mode, the uninstallation process does
not present any dialogs for user interaction.

Note: If you do not specify an option for uninstalling , the uninstaller runs in
the mode in which is installed.
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company's designated support contact can log a call with
IBM technical support. Use these guidelines to ensure that your problem is
resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
administrator for information.

Note: Technical Support does not write or create API scripts. For assistance in
implementing our API offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages that you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM technical support, you might be asked to provide information
about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, check for a version.txt file that is located under the installation
directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support
website: (http://www.ibm.com/support/entry/portal/open_service_request).

Note: To enter a support request, you must log in with an IBM account. This
account must be linked to your IBM customer number. To learn more about
associating your account with your IBM customer number, see Support Resources
> Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
B1WA LKG1
550 King Street
Littleton, MA 01460-1250
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
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platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at "Copyright and
trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations
IBM Software products, including software as a service solutions, ("Software
Offerings") may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that
identifies your computer. In many cases, no personal information is collected by
these cookies. If a Software Offering you are using enables you to collect personal
information through cookies and similar technologies, we inform you about the
specifics below.

Depending upon the configurations deployed, this Software Offering may use
session and persistent cookies that collect each user's user name, and other
personal information for purposes of session management, enhanced user usability,
or other usage tracking or functional purposes. These cookies can be disabled, but
disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through
cookies and similar technologies. If the configurations deployed for this Software
Offering provide you as customer the ability to collect personal information from
end users via cookies and other technologies, you should seek your own legal
advice about any laws applicable to such data collection, including any
requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's
website terms of use (e.g. privacy policy) which includes a link to IBM's and
Client's data collection and use practices, (2) notify that cookies and clear gifs/web
beacons are being placed on the visitor's computer by IBM on the Client's behalf
along with an explanation of the purpose of such technology, and (3) to the extent
required by law, obtain consent from website visitors prior to the placement of
cookies and clear gifs/web beacons placed by Client or IBM on Client's behalf on
website visitor's devices

For more information about the use of various technologies, including cookies, for
these purposes, See IBM's Online Privacy Statement at: http://www.ibm.com/
privacy/details/us/en section entitled "Cookies, Web Beacons and Other
Technologies."
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